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About this manual
This user manual is divided into three chapters. Chapters 1 and 2 provide
background information and chapter 3 provides detailed user information
as follows:

• Chapter 1 - DCN Automatic Camera Control - containing general infor-
mation about the DCN Automatic Camera Control software, and the
two different versions available.

• Chapter 2 - Getting Started - containing details about installing the
stand-alone version of the software, and information about starting the
application from the DCN Startup screen and from a shortcut icon.
There is also a description of the Help facility.

• Chapter 3 - Using DCN Automatic Camera Control - containing details
about configuring the software, assigning cameras to seat/unit numbers,
specifying camera type, editing camera IDs, importing and exporting
camera settings and printing Camera Installation files.

An appendix provides additional reference information that will be helpful
to experienced users. This consists of:

• A.1 - Overview of DCN Automatic Camera Control menus
• A.2 - Short-cut (accelerator) keys
• A.3 - Alphabetic index

EXPLANATORY NOTES
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Manual conventions
For clarity this user manual uses consistent styles, symbols and 
typographical conventions. They are:

NOTE: General notes are contained within rules and indicated with this 
symbol in the left margin. Notes are used to draw attention to special actions
or information.

CAUTION: A caution is contained within rules and indicated with this sym-
bol in the left margin. Cautions are used to draw attention to actions or com-
mands that could lead to a loss of information or damage to equipment

A tip is contained within rules and indicated with this symbol in the left mar-
gin. Tips are used to provide supplementary information that may make an
action quicker or easier to carry out.

• An action (to be carried out by the user) is shown on a grey background
and indicated with a round bullet mark.

Typographical conventions
The following are typographical conventions (text styles) are used in this
manual:

• Typed input - information to be typed in using the keyboard is shown
as:

Filename

• Single key - input via a single key (or keys) on the keyboard is shown as:
<enter>, <shift>, etc.

• Multiple keys - input via a combination of keys pressed together is
shown as:

<ctrl>+<p>, <alt>+<f4>

• Screen text - information that appears on screen is shown as:
‘Choose Startup Modules:’

NOTE: Some keyboards use <RETURN> instead of ‘Enter’. Functionally,
these keys are identical.
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1.1 ABOUT DCN AUTOMATIC CAMERA CONTROL

What is DCN Automatic Camera Control?
The DCN Automatic Camera Control software is designed to interface
DCN congress systems with Bosch Allegiant switchers or a single
AutoDome camera. It selects fixed or pre-positioned cameras to be activated
to display the current active speaker at a conference. 

Camera Control in congress applications
When a chairman’s or delegate’s microphone is activated on the DCN
equipment, the camera assigned to that position is activated. When no
microphones are active, an overview camera is automatically selected. The
image can be displayed on hall displays or other monitors together with
information about the current speaker if required (such as delegate identifi-
cation). The system operator has a monitor, which also displays information
about which camera is active. This system provides an extra dimension to
congress and conference proceedings. 

NOTE: The Allegiant video control switcher cannot display graphic characters
that are used in certain non-European and non-US languages such as Chinese.

DCN AUTOMATIC CAMERA CONTROL
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1.2 STAND-ALONE AND DCN SYSTEM VERSIONS

There are two versions of DCN Automatic Camera Control software avail-
able:
• LBB 3588 is for DCN systems with a CCU and a control PC. The acti-

vation and installation of the cameras is integrated into the DCN PC
control software.

• LBB 3562 is for DCN stand-alone systems without PC control.

Both versions of the application are described in this user manual. The dif-
ferences between the two versions are described below.

NOTE: This user manual is primarily written with reference to the LBB 3588
version of the software. Any differences pertaining to the LBB 3562 stand-
alone software version are described as they occur.

Differences between stand-alone and DCN system versions 
The main difference is that the stand-alone version operates without a con-
trol PC. A PC need only be connected for programming the CCU. The PC
running the stand-alone software is disconnected from the CCU after the
software has been used, but in a DCN system with control PC, the PC
remains connected to the CCU. 

There are also minor differences in functionality between the two software
versions. These are described elsewhere in this manual.

NOTE: Both software versions can be used in single CCU or multi CCU sys-
tems. The maximum number of seats which can be linked to cameras or cam-
era prepositions is 1500.
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1.3 OVERVIEW OF DCN AUTOMATIC CAMERA CONTROL 

An overview of the procedure for using the DCN Automatic Camera Control
software with a DCN system is given below. 

Systems using DCN Control PC
The DCN Automatic Camera Control software is installed on the DCN con-
trol PC. The control PC is connected to the CCU, which in turn is connected
to delegates’ contribution units. The CCU is also connected to a single
AutoDome camera or an Allegiant video switcher, which in turn is connected to
the cameras and monitors in the system. After connecting the system, the DCN
Automatic Camera Control software is used to configure the cameras. The con-
trol PC remains connected to the CCU while the system is being used.

Stand-alone systems
In stand-alone systems, a temporary PC connection to the CCU and
AutoDome camera or Allegiant video switcher is needed during camera installa-
tion. The numbers assigned to the contribution units during DCN system ini-
tialisation are coupled to camera positions. After configuration is complete, the
PC is disconnected from the system, and a direct connection from the CCU to
the AutoDome camera or the Allegiant video switcher is made. Operational
camera control by the CCU is enabled during installation. To disable opera-
tional camera control, it is necessary to re-connect the installation PC and open
the Camera Installation file.

NOTE: For details on connections refer to the section DCN Camera Control
of the Installation and Operating Manual.
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2.1 STARTING THE DCN AUTOMATIC CAMERA 
CONTROL SOFTWARE

The DCN Startup screen
The DCN Automatic Camera Control module is started from the DCN
Startup screen (shown below).

NOTE: For starting the DCN Startup program from an icon on the desktop,
refer to the Startup user manual.

NOTE: The stand-alone version of the DCN Automatic Camera Control soft-
ware is started from the ‘Programs’ option of the ‘Start’ menu on the Win-
dows desktop.

GETTING STARTED

DCN Automatic Camera Control Digital Congress Network
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The DCN Automatic Camera Control software version (LBB 3588) which
uses a DCN control PC  uses two user-created files that contain important
information about the installed hardware configurations and about dele-
gates’ names. These files are:
• Installation file - containing information about the channel assignment

and the seat numbers that have been assigned to all microphones and
cameras connected to the DCN. These seat numbers are assigned using
the System Installation software (LBB 3585).

• Names file - containing details about the names of and details of partici-
pating delegates, and which seat number they occupy. These names are
assigned using the Delegate Database software (LBB 3580).

The seat numbers defined in System Installation are used to assign cameras
to delegates’ DCN contribution units. All information and settings defined
in the DCN Automatic Camera Control software are added to the installa-
tion file.

NOTE: An installation file must be open before camera installation is possi-
ble. However, the DCN Automatic Camera Control software can be started
without an installation file being open.

NOTE: The stand-alone version of the DCN Automatic Camera Control soft-
ware does not use other DCN software modules. 

NOTE: For specifying an installation file from the DCN Startup main window,
refer to the System Installation user manual.

The DCN Automatic Camera Control icon
For details on the DCN Automatic Camera Control icon and how to start
the software from Startup, please refer to section 3.2 of the Startup user
manual, under the heading ‘Opening other modules from Startup’. 
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2.2 INSTALLING THE STAND-ALONE DCN AUTOMATIC 
CAMERA CONTROL SOFTWARE

PC requirements and settings
For information about PC requirements and settings, please refer to 
the DCN Installation and Operating Manual, under the section 
Camera Control . In particular, please note that in multi-CCU systems 
the following line must be changed in the CCU_ CFG file of the 
Multi-CCU control software LBB 3586.
SERIALPROTOCOL1 SIMPLE must be changed to:
SERIALPROTOCOL1 CAMERA

The multi-CCU control PC port settings for communication with the Alle-
giant Video Switcher should be as follows:
SERIALPORT1 x
(where x = 1 or 2 depending on the actual PC port used for communication
with the video switcher. The default setting is 2).
SERIALSPEED1 19200
SERIALPROTOCOL1 CAMERA

Installing the stand-alone software
To install the stand-alone version of the DCN Automatic Camera Control
software:

• Insert the installation disk with type number LBB 3562/0x.

• Select ‘Run...’ from the ‘Start’ menu on the Windows desktop.

• Type a:setup on the command line which appears.

• Follow the on-screen instructions.

When installation has been successfully completed, a new program group
called Standalone Camera Control Installation is created. Please refer to sec-
tion 2.1,‘Starting the DCN Automatic Camera Control software’, for infor-
mation about starting the module.

NOTE: Before beginning camera installation, it is important to make sure
that the Allegiant video switcher, system cameras and monitors are properly
connected and installed. For more information, refer to the DCN Installation
and Operating Manual.

GETTING STARTED
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2.3 USING HELP

The Help menu
The ‘Help’ menu in the title bar contains commands for an on-screen help
facility. This help facility contains information on all commands in the
menu bar, on which keyboard keys are functional, a description of how to
use the DCN Automatic Camera Control software, information on how to
use the ‘Help’ facility itself, plus an index and a glossary of terms. All infor-
mation contained in this user manual can also be found in the ‘Help’ facili-
ty. 

The ‘Help’ facility contains the following options:
• Index
• Keyboard
• Commands
• Procedures
• Glossary
• Using Help
• About...

Index
To access the index:

• Select the ‘Help’ menu and click on ‘Index’.

A full list of subjects covered by the ‘Help’ facility is given in alphabetical
order. For more information on any subject contained in the index:
• Click on the required subject in the index.

An on-screen page with the requested information will appear.

Keyboard
This gives information on which keys on your keyboard can be used with
the DCN Automatic Camera Control software. This includes using keys to
activate menu items, to move around in dialogue boxes, for short-cuts, and
to select options from the main window. To access the ‘Keyboard’ help
facility:
• Select the ‘Help’ menu and click on ‘Keyboard’.

GETTING STARTED
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A list of different key types is given. For more information on any key type
contained in the list:
• Click on the required key type in the list.

An on-screen page with the requested information will appear.

Commands
This gives information on all options contained in the menu bar. This 
covers the ‘View’, ‘Print’, ‘Settings’ and ‘Help’ menus. To access the ‘Com-
mands’ help facility:
• Select the ‘Help’ menu and click on ‘Commands’.

A list of file menu groups is given. For more information on any menu
group contained in the list:

• Click on the required menu group in the list.

A list of options in the selected menu group is given. For more information
on any option contained in the list:
• Click on the required option in the list.

An on-screen page with the requested information will appear.

Procedures
This gives information on how to use the DCN Automatic Camera Control
software. To access the ‘Procedures’ help facility:
• Select the ‘Help’ menu and click on ‘Procedures’.

A list of topics is given. For more information on any topic contained
in the list:
• Click on the required topic in the list.

A list of options for the selected topic is given. For more information on
any option contained in the list:
• Click on the required option in the list.

An on-screen page with the requested information will appear.

GETTING STARTED
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Glossary
To access the glossary:
• Select the ‘Help’ menu and click on ‘Glossary’.

A list of terms used in the DCN Automatic Camera Control help facility is
given in alphabetical order. For more information on any term contained in
the glossary:
• Click on the required subject in the glossary.

A window with the requested information will appear.

Using Help
This gives information on how to use the DCN Automatic Camera Control
help facility. To access the ‘Using Help’ facility:

• Select the ‘Help’ menu and click on ‘Using Help’.

A list of topics is given. For more information on any topic contained
in the list:
• Click on the required topic in the list.

A list of options for the selected topic is given. For more information on
any option contained in the list:
• Click on the required option in the list.

An on-screen page with the requested information will appear.

About DCN Automatic Camera Control
This provides software release information. To display the ‘About...’
window:
• Select the ‘Help’ menu and click on ‘About ...’.

GETTING STARTED

Download from Www.Somanuals.com. All Manuals Search And Download.



The following window appears:

To remove this window:

• Click on the ‘OK’ push button.
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3.1 THE CAMERA INSTALLATION MAIN WINDOW

The Camera Installation main window is used to assign fixed cameras and
camera positions (on preposition cameras) to DCN units. 

There are two main types of camera recognized by the DCN Automatic
Camera Control software. Fixed cameras are positioned before the confer-
ence begins, and they remain in the same position during the conference.
Dome cameras can adjust their position automatically in response to confer-
ence activity. For example, a dome camera normally has several preposi-
tions, determined during configuration, each covering a different delegate
or group of delegates. The camera will automatically change position to
cover the delegate who is speaking.
The Camera Installation window at startup is shown below.

NOTE: The System Installation file is required for using DCN Automatic
Camera Control with a software-controlled DCN system. This file is loaded
from the Startup screen. In the example used in this manual, 10 DCN seats
have been assigned in the System Installation file.

NOTE: In the stand-alone version of the software, ‘seats’ are referred to as
‘units’.

USING DCN AUTOMATIC CAMERA CONTROL
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The Camera Installation window contains the following elements:
• Start/Stop push button. This is used to enter and exit Installation mode.
• Camera specification edit fields for entering camera number, camera ID,

and the type of camera (fixed or preposition)

When installation mode is entered (by pressing the Start push button) for 
the first time i.e. when no cameras have yet been assigned to seat numbers,
or when camera 1 is selected from the ‘Assignments’ list the installation win-
dow appears as follows:

NOTE: If a camera with prepositions (such as a dome camera) is selected,
the number of prepositions available, and the selected preposition is also
entered in this area.

• ‘Selected preposition:’ edit field (only displayed if the camera is a preposi-
tion type)

• DCN seat (or unit) edit fields for selecting a seat (or unit) number and
entering one or two lines of seat/unit text

• ‘Insert’ button for entering the camera and unit assignments specified (it
then appears in the ‘Assignments’ list on the right side of the main win-
dow)

Digital Congress Network DCN Automatic Camera Control
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Fig. 2 The Camera Installation window 
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• ‘Delete’ button for removing camera and unit assignments from the
‘Assignments’ list.

• ‘Assignments’ list for displaying assigned camera data. 

The menu bar
All menu options referred to in this user manual are contained within the
menu bar located under the title bar at the top of the Camera Installation
window. The full list of menu options is as follows:

3.2

USING DCN AUTOMATIC CAMERA CONTROL
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Fig. 3 All available menu options on the menu bar

File Settings!… Configuration Camera List!… Help
Camera Index
Activity Keyboard
Clear all Commands
Print… Procedures
Import… Glossary
Export… Using Help
Exit About…
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ASSIGNING CAMERAS TO SEAT/UNIT NUMBERS

NOTE: Before you start the installation process make sure that the configu-
ration is correctly set.

To start the camera installation process:

• Click on the ‘Start’ button.

NOTE: The ‘Start’ button toggles to a ‘Stop’ button when activated. Dur-
ing camera installation, all conference activities will be stopped.

The following warning appears:

• Click on ‘OK’ to continue with camera installation.

If there is no communication between the CCU and the Allegiant video
switcher, the following error message appears:

• Click on ‘OK’ and ensure that the connection, cable and communica-
tion settings between the Allegiant video switcher and the CCU are 
correctly made.

NOTE: In case of DCC there is no warning when there is no connection
between the AutoDome and the CCU.
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Fig. 4 Camera installation warning

Fig.5 No connection to video switcher error message
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The following window appears:

Specifying the overview camera
For AVS Camera 1 is always reserved for the overview. For DCC the high-
est pre-position is reserved for the overview. The overview gives a general
overview of the conference venue when all the microphones are off (and
therefore no conference participant is on camera). In case of AVS the
overview camera can also be used when a dome camera is moving from one
preposition to another. It acts as the default camera, and is activated when
no other camera is selected by the Allegiant video switcher in response to
conference activity.

The overview camera can be either a fixed or dome camera. However, in
single-camera configurations, the overview camera is always a dome camera
with its last preposition showing the overview.

NOTE: When a dome camera is used as the overview camera, the ‘Cam-
era movement time’ option is disabled.

If a fixed camera is used, the edit fields for seat (or unit) number and text
are not displayed. It is not possible to assign this camera to a seat or unit.
The following screen text is displayed:

‘This camera is reserved for the overview’

USING DCN AUTOMATIC CAMERA CONTROL
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Fig. 6 The Camera Installation window 
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NOTE: The camera ID for camera 1 is ‘greyed’ and cannot be edited.

More detailed information about defining cameras is given later in this sec-
tion. After defining the overview camera, it is necessary to save the setting.
To do so: 
• Click on the ‘Insert’ button.

The overview camera information will appear in the ‘Assignments’ list of
the Camera Installation window. The next seat or unit number which has
not yet been assigned to a camera will appear in the edit fields of the Cam-
era Installation window.

Selecting a seat (or unit) number 
In DCN systems with PC control, the DCN Automatic Camera Control
software takes the seat numbers from the current installation file. In DCN
systems with a stand-alone CCU, the DCN Automatic Camera Control
software uses ‘unit’ numbers instead of ‘seat’ numbers.

To enter or change the camera control settings for a delegate’s contribution
unit, it is first necessary to select that unit’s seat or unit number. There are
two ways of selecting a seat or unit number.

The DCN Automatic Camera Control software will automatically propose
a seat or unit number in the ‘Seat nr:’ edit field of the Camera Installation
window. It is possible to accept this number, or to change it using the up
and down arrow keys of the edit field. 
Alternatively, it is possible to press the microphone button or any of the soft
keys on a contribution unit. This will automatically result in the seat or unit
number and any other entered parameters appearing in the Camera Installa-
tion window.

NOTE: Selecting a seat or unit number causes the LEDs of the soft keys, and
the microphone LED on the corresponding contribution unit to flash.

NOTE: After pressing the ‘Insert’ push button, the software automatically
loads the next seat or unit number which has not been assigned to a camera.

The total number of seats (or units) which have not yet been assigned to a
camera is displayed in the Camera Installation main window in the lower
right-hand corner:

‘n seats without camera assignment’
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Where ‘n’ is the number of seats (or units). 

Only seat (or unit numbers) without camera assignment can be selected.

NOTE: During installation, the audience monitor continues to show the
image from the overview camera, except in one-camera configurations where
it will show the same view as the operator monitor. The operator monitor
shows the selected camera picture.

Selecting camera number
To continue with the camera installation, a camera number should be
assigned to each seat or unit number. To do so:

• Select the number of the camera you want to assign.

Editing camera ID
Each camera can have a descriptive ID (maximum 16 characters) entered in
the ‘Camera ID:’ edit field. This, for example, could be used to give each
camera a descriptive ID relating to the position of the camera in the confer-
ence venue. This text appears on the operator monitor but not on audience
monitors.

To enter or edit the camera ID:
• Select the ‘Camera ID’ edit field.

• Enter the required text.
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Specifying camera type
For AVS the type of camera (fixed or preposition) must be specified. To
specify a fixed camera:
• Click on the ‘Fixed:’ check box.

A tick mark (√) appears to indicate that a fixed camera type has been 
selected been selected. (This option is not available for DCC).

• Click on the ‘Fixed:’ check box again to deselect it.

NOTE: When the ‘Fixed:’ check box is not ticked the ‘Number of prepo-
sitions:’ and ‘Selected preposition:’ edit fields are visible.

The camera edit fields now appear as follows:

The ‘Number of Prepositions’ edit field (default 99) and the ‘Selected prepo-
sition’ edit field appear. To assign a preposition to a seat (or unit):
• Click on the scroll-up or scroll-down button on the ‘Selected preposi-

tion’ edit field.
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Fig. 8 Camera edit fields for fixed cameras

Fig. 9 Camera edit fields for preposition cameras
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NOTE: When a preposition is changed, the operator monitor displays the
image assigned to that preposition number using the Allegiant video switcher. 

Once the preposition is selected it must be defined using the joystick on 
the Allegiant or virtual keyboard. For more information, refer to the user
documentation for the Allegiant or virtual Keyboard. When you have
defined the preposition:
• Click on ‘Insert’ to enter the setting. 

If a preposition that is already in use is selected, the following warning
appears when the ‘Insert’ button is pressed:

Entering seat (or unit) text
One or two lines of text can be entered for each seat (or unit). 
The text appears on both the operator monitor and audience monitors. 
To enter seat (or unit text):

• Select the ‘Seat nr:’ edit field, and enter the required text.

NOTE: If ‘Double Seat Text’ is selected in the ‘Settings’ dialogue box, two
lines of text can be entered.
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Fig. 10 Preposition in use warning

Fig. 11 Seat (or unit) text editing
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Inserting seat (or unit) numbers and camera settings
When the seat (or unit) and camera settings are correct, the camera can be
assigned to the seat (or unit). To do so:
• Click on the ‘Insert’ button.

The Seat number, camera number, preposition number (if applicable) and
screen text is stored and displayed in the ‘Assignments:’ list. An example of
the ‘Assignments:’ list is shown below.

Editing entries in the ‘Assignments:’ list
It is possible to recall entries in the ‘Assignments:’ list. This allows you to
change their settings. To do so:

• Double-click on the entry in the ‘Assignments:’ list to be edited.

The chosen entry and its settings will appear on the left-hand side of the 
‘Camera Installation’ window.

Digital Congress Network DCN Automatic Camera Control
Page 3-11 Software User Manual

USING DCN AUTOMATIC CAMERA CONTROL

3

Fig. 12 Complete assignment list

Download from Www.Somanuals.com. All Manuals Search And Download.



Deleting a camera assignment from the ‘Assignments:’ list
When the seat (or unit) and camera settings are incorrectly entered or have
been changed, an entry in the list can be deleted. To do so:
• Click on the entry in the ‘Assignments:’ list to be removed.

The text becomes highlighted.
• Click on the ‘Delete’ button.

The entry is removed from the list.

It is also possible to delete an entry from the ‘Assignments:’ list by using the 
‘Camera List!’ option on the main menu bar. To do so:

• Click on the ‘Camera List!’ option on the main menu bar.
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Fig. 13 Deleting an item from the assignment list
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The following window appears:

This window gives an overview of all installed cameras and their settings.
To delete a camera and its settings:

• Click on the entry in the ‘Camera List’ to be removed.

The text becomes highlighted.
• Click on the ‘Delete’ button.

• Click on the ‘Close’ button.

The entry is removed from the list.

NOTE: The seat (or unit) numbers which have not been assigned to a cam-
era are automatically updated.
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Fig. 14 The Camera List window
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3.3 SYSTEM SETTINGS

The DCN Automatic Camera Control module has the following system
settings:
• Screenline usage (DCN with control software and names file only)
• Double seat text
• Camera override
• Camera movement time
• Number of audience monitors

NOTE: For AVS the above system settings are all active in installation mode.
In case of DCC only the option Camera Override is available.

To enable the settings window:

• Click on the ‘Settings…’ menu.

The following window appears.
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Screenline usage
When enabled, this option takes the screenline (text displayed on the audi-
ence monitor) as defined in the Delegate Database DCN software. The
option is enabled by default. To enable/disable this option:
• Click on the ‘Screenline usage’ check box.

A tick mark (√) appears to indicate that this option has been enabled.

NOTE: If the ‘Double text’ option is selected, two lines of 16 characters
can be displayed. Otherwise, only one line of 16 characters can be shown.

NOTE: If no names file is currently open (as specified in Delegate Database)
or this option is de-selected (off), the seat text (as specified in the main win-
dow) is displayed. The DCN Automatic Camera Control software for stand-
alone CCU systems always displays the unit text (the ‘Screenline usage’
option is not displayed).

Double seat (or unit) text
An additional line of text can be entered for each seat (or unit). The text
appears on both the operator monitor and audience monitors. By default,
this option is not enabled. To enable the option:
• Click on the ‘Double seat (or unit) text’ check box.

A tick mark (√) appears to indicate that this option has been enabled.

The ‘Seat (or Unit) text:’ edit field now appears as follows:
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Camera override
The ‘Camera override’ option allows you to determine whether a newly-
switched on microphone automatically activates the camera covering its
position, or whether the camera is only activated when the current micro-
phone is switched off. To activate this option:
• Click on the ‘Camera override’ check box.

Camera movement time
To hide camera movement (as a preposition camera moves from one posi-
tion to the next), the overview camera can be activated and displayed during
the movement. This option enables the period for which the camera move-
ment is hidden to be set between 0.5 seconds and 60 seconds in 0.5 second
steps. The default is 1 second. To alter the camera movement time:

• Use the up and down arrow keys to select the required setting.

NOTE: This function can only be activated if the overview camera is a fixed
camera. A setting of 0 seconds disables the option.

Number of audience monitors
The number of audience monitors (excluding the operator monitor) can be
set to between 1 and 4. All audience monitors show the same picture. The
default is 1 audience monitor. To alter the number of audience monitors:
• Use the up and down arrow keys to select the required setting.

NOTE: It is recommended that the number selected corresponds to the actu-
al number of audience monitors present in the venue. If the number selected
is higher than this, there may be some reduction in system performance.

After you have made all the required settings:
• Click on the ‘OK’ push button.

The settings will be saved, and you will return to the ‘Camera Installation’
window. To exit the ‘Settings’ window without saving any changes:
• Click on the ‘Cancel’ push button.

NOTE: In stand-alone systems, when all settings have been specified and the
Camera Control software has been exited, it is necessary to make a direct
connection between the CCU and the Allegiant video switcher to enable cam-
era control by the DCN system. For information concerning the required con-
nections, refer to the DCN Installation and Operating manual Addendum.

USING DCN AUTOMATIC CAMERA CONTROL
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3.4 THE FILE MENU

The file menu contains the following:
• Camera Activity
• Clear all (resets complete Assignment list)
• Print… (prints out camera and seat (unit) data
• Import…(imports a Camera Installation configuration file)
• Export… (exports a Camera Installation configuration file)
• Exit (closes the Camera Installation program)

Camera activity
When activated, this function transmits control commands to the Allegiant
switcher (AVS) or the AutoDome camera (DCC). If switched off, the CCU
will not transmit these commands. This function is useful if you wish to
disable camera control functionality in the DCN CCU. By default, camera
activity is enabled.

To disable this function:

• Select ‘File’ and click on ‘Camera Activity’.

A tick mark appears to indicate that this option has been enabled.

Clear all
This menu command clears all entries in the assignment list.
To enable this function:
• Select ‘File’ and click on ‘Clear All’.
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Printing
It is possible to print a hard copy of the current Camera Installation file. To
do so:
• Select ‘File’ and click on ‘Print’.

The following dialogue box appears:

It is possible to specify that seat assignments are included in the printout.
To do so:

• Click on the ‘Seat assignments’ check box.

A tick mark (√) appears to indicate that this option has been enabled.

You can also specify that camera definitions are included in the printout.
To do so:
• Click on the ‘Camera definitions’ check box.

A tick mark (√) appears to indicate that this option has been enabled.

Up to nine copies of the Camera Installation file can be printed. To select
the number of copies:
• Use the up and down arrow keys to select the required number.
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Fig. 17 The ‘Print’ dialogue box
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After selecting the print settings:
• Click on the ‘OK’ push button.

To exit the dialogue box without printing anything:
• Click on the ‘Cancel’ push button.

You will return to the main window.

Importing and exporting Camera Installation files
It is possible to import and export Camera Installation files containing
information about the configuration and settings of the DCN Automatic
Camera Control software. For systems where a DCN control PC is used,
this information is automatically stored in the current installation file.
However, importing and exporting Camera Installation files may be useful
in situations where you wish to use more than one configuration with an
installation file.

NOTE: The DCN control PC can only import information relating to seat
numbers which are present in the current System Installation file.

NOTE: In stand-alone systems, configuration settings are saved automatically
on the PC and on the DCN CCU. These settings reappear when the PC is
switched on. The import/export functions are a useful way of making backups,
and saving/retrieving configuration settings.

NOTE: Only files valid for the used (AVS or DCC) system configuration can
be imported.
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Importing Camera Installation files
The Import function allows configuration files to be retrieved in .txt or .csv
formats. 

NOTE: The ‘Import...’ option is only active in installation mode. Only files
valid for the used (AVS or DCC) system configuration can be imported.

To import a configuration file:
• Select ‘File’ and click on ‘Import...’.

The following window appears:

• Select the Camera Installation file you wish to import.

• Click on the ‘OK’ push button.

The Camera Installation file will be imported into the DCN Automatic
Camera Control software.

CAUTION: The information imported into the DCN Automatic Camera Con-
trol software will overwrite the current settings.

Fig. 18 The ‘Import Camera Installation file’ window
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Exporting Camera Installation files
The Export function allows configuration files to be saved in a file location
of your choice. To do so:
• Select ‘File’ and click on ‘Export...’

The following window appears:

• Select the name and location of the file you wish to export.

NOTE: By default, the location for exporting camera installation files is
c:\dcn\export

• Click on the ‘OK’ push button.

The Camera Installation file will be exported to the selected location.

Fig. 19 The ‘Export Camera Installation file’ window
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3.5 EXITING DCN AUTOMATIC CAMERA CONTROL  

Minimizing DCN Automatic Camera Control
It is possible to minimize DCN Automatic Camera Control. To do so:
• Click on the ‘minimize’ button situated at the top right of the 

application window. 

The program will become iconized in the Windows desk-top. When the
program is iconized, it still remains active.

To re-enter DCN Automatic Camera Control:
• Click on the program icon.

Exiting DCN Automatic Camera Control
If you wish to exit DCN Automatic Camera Control:

• Click ‘exit’ in the ‘file’ menu.

All settings are automatically saved and you will return to the Windows
desk-top.

You can also exit DCN Automatic Camera Control by clicking on the 'close'
button on the far top right corner of the window.

NOTE: By closing the Startup program, all DCN applications including DCN
Automatic Camera Control will close. 

NOTE: If 'Camera activity' is enabled camera control remains active when
the software is closed.
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A.1 CONTROL MENUS                                  

File menu
The ‘File’ menu covers clearing, printing, importing, exporting and termi-
nating the application. The menu consists of the following items: 
• Clear all allows the user to clear the camera assignments list (refer to

page 3-17).
• Print... allows the user to print up to nine copies of a Camera Installa-

tion file (refer to page 3-18).
• Import... allows the user to import camera configuration data into the

DCN Automatic Camera Control software (refer to page 3-20).
• Export... allows the user to export camera configuration data out of the

DCN Automatic Camera Control software (refer to page 3-21).
• Exit terminates DCN Automatic Camera Control (refer to page 3-22).

Settings!... 
This option allow the user to specify camera control settings including
screenline usage, camera override, camera movement time and the number
of audience monitors.

Configuration
This option determines whether or not you use an Allegiant video switcher.

Camera List!...
This option allow the user to view the cameras which have been assigned to
seat (or unit) numbers. It can also be used to delete assigned cameras. 

Help menu
The ‘Help’ menu manages the on-line help related to the whole DCN
application. The menu consists of the following items:
• Index provides the user with an alphabetical list of subjects covered by

the help facility (refer to page 2-5).
• Keyboard provides the user with information on which keyboard keys

can be used with the software (refer to page 2-5).
• Commands provides the user with information on all options contained

in the file menu (refer to page 2-6).
• Procedures provides the user with information on how to use the soft-

ware (refer to page 2-6).
• Glossary provides the user with an alphabetical list of terms used in the

help facility (refer to page 2-7).
• Using Help provides the user with information on how to use the help

facility (refer to page 2-7).
• About... displays the dialogue box with software release information

(refer to page 2-7).
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A.2 ACCELERATOR KEYS 

DCN Automatic Camera Control accelerator (short-cut) keys

Menu Item Short-cut

File <ALT> + <F>

Clear all <C>

Print <P>

Import <I>

Export <E>

Exit <x>

Settings!... <ALT> + <S>

Configuration <O>

Camera List!... <ALT> + <C>

Help <ALT> + <H>

Index <I>

Keyboard <K>

Commands <C>

Procedures <P>

Glossary <G>

Using Help <U>

About... <A>

A
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